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ABSTRACT 

A numerical simulation of three dimensional heat transfer in a silicon based microchannel heat 

sink has been conducted using nanofluid (TiO2-H2O) by SIMPLE method. Model of 

microchannel consists of trapezoidal channel. Dimensions of trapezoidal microchannel are 10 

mm length, 280 μm channel top width, 225 μm channel bottom width, 431 μm channel 

hypotenuse and 430 μm channel height. Influence of properties of nanofluid on the heat transfer 

is investigated. Different parameters like heat transfer coefficient, Nusselt number, heat flux, 

outlet temperature are studied for different pressure drop. Pumping power depends upon pressure 

difference. So power consumption can be optimized by this study. Result shows that heat transfer 

coefficient is high in comparison to the water as a coolant in microchannel heat sink. Because of 

boundary layer, variation of Nusselt number decreases along the flow direction. 
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Chapter 1                                                                 INTRODUCTION 

 

1.1 General  

Cooling of electronic chip is essential for the proper functioning of electronic device, in which it 

is used. At present time it has become major concern to electronic packaging engineers. Most of 

the electronic devices face problem of improper cooling of electronic chip, which results failure 

of device. Failures are caused due to temperature rise because of accumulation of heat. Electronic 

gadgets have become ultra-compact. With invention of integrated circuit, trend has shifted 

toward higher packaging density. In past few decades an exponential increment occurred in 

density of circuit.  

With the rapid development of the information technology (IT) industry, the heat flux in 

integrated circuit (IC) chips cooled by air has almost reached its limit about 1000000 W/m2. Even 

in some applications, in high technologies, require heat fluxes well beyond such a limitation. So 

for the further development of IT industry a better cooling method has become a bottleneck 

problem. Even after the replacement of air cooling by liquid cooling, results are not totally 

satisfactory.  

For development of compact and efficient thermal management technology for advanced 

electronic devices, cooling devices have to be in light-weight, small in size and of high 

performance. Microchannel heat sink can play an important role in this requirement. 

Microchannels are very fine channels of the width of a normal human hair and are widely used 

for electronic cooling purposes. In a MCHS, multiple microchannels are stacked together, which 

can increase the total contact surface area for heat transfer enhancement. MCHS reduces the total 

pressure drop by dividing the flow among many channels. Liquid or gas is used as a coolant to 

flow through these microchannels. The large surface area of MCHS enables the coolant to take 

away large amounts of energy per unit time per unit area while maintaining a considerably low 

device temperature. Using these MCHS, heat fluxes can be dissipated at relatively low surface 

temperatures. 

This chapter deals with the  causes of heat generation in computer system, different cooling 

methods for computer system like air cooling, liquid immersion cooling hybrid air-water cooling 
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and refrigerant cooling. After it heat sink is described along with microchannel heat sink. 

Different working fluid which are used in microchannel heat sink are also discussed in last 

section of first chapter. 

1.2 Causes of Heat Generation in Computer System  

 
 Following table shows the causes of failure of electronic chip and percentage corresponding to 

the cause- 

 

               Cause of Failure                       Percentage Of Failure 

                Vibration                       20% 

                Temperature                       55% 

                 Dust                       6% 

                 Humidity                       19% 

 

                Table 1.1 Different Causes of Failure of Electronic Chip 

From table it is very clear that failures due high temperature is very high. It is due to the heat 

generation. Heat generated by CPU is function of frequency and voltage upon which it operate. 

It also depends upon the design and construction of CPU. During operation, the temperature of 

components will rise until the thermal equilibrium is achieved. It means temperature gradient 

between the computer’s components and their surroundings is such that the rate at which heat is 

lost to the surroundings is equal to the rate at which heat is being produced by the electronic 

component.   

Dust blocks the flow of air. It acts as a thermal insulator. Thus it effect’s the performance of 

cooling fan and also of heat sink. Vibration and humidity also contribute in heat generation and 

ultimately failure of system. 
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1.3 Different Cooling Methods for Computer System  

Before going in detail of microchannel heat sink, it is important to know the various types of 

techniques used for cooling of integrated circuit. It may be chipset, central processing unit (CPU) 

in computer industry and data centers. The techniques used are listed below- 

 

1.3.1 Air Cooling  

In this method air is moved around or to computer enclosures by some means. Generally fans are 

commonly used for accomplishing that task. The term computer fan usually refers to fans 

attached to computer enclosures, but may also be intended to signify any other computer fan, 

such as a CPU fan. Different fans of varying sizes are available as from 40 to 240 mm. In 

desktops one or more fans are used for heat dissipation. It is recommended by most 

manufacturers that to bring fresh and cool air in from the bottom front of the case, and exhausting 

warm air from the top rear. 

Air cooling is also used in laptops. In these, fan forces the air through small port. So fan can be 

choked. It will cause overheating. Ultimately failure of component may occur. 

In data centres, number of computers is very high. There is a risk of overheating of various 

components if proper cooling method is not applied. There are a number of flat severs. Air enters 

from the front of the rack and comes out from the back. Generally in such application heating 

ventilation air conditioning is applied. 

 

                                         

                                                                    

Fig 1.1 Cooling Fan 

Source: http://www.extremetech.com/computing/107147-intels-liquid-cpu-cooler-is-water-

worth-the-cost 
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1.3.2 Liquid Immersion Cooling  

No fan is used in this cooling method. Components of computers to be cooled are submerged 

into the thermally conductive liquid. Liquid must have low electrical conductivity. It must not 

interfere with working of computer’s components. Parts susceptible to electromagnetic 

interference must be insulated. Dielectric liquid should be preferred.  In this method, evaporation 

can create a problem. Refilling of liquid should be done regularly. Sometimes liquid seeps in 

damaged components. Finally, it will cause failure of component. The liquids used in the cooling 

of electronic equipment must meet several requirements, depending on the specific application. 

 

                               

 

Fig 1.2 A liquid cooled CPU in a clear case 

Source: http://computer.howstuffworks.com/liquid-cooled-pc.htm 

 

Desirable characteristics of cooling liquids include –  

 

 High Thermal Conductivity – It will yield high heat transfer coefficients. 

 High Specific Heat –It requires smaller mass flow rate.  

 Low Viscosity – It causes a smaller pressure drop and thus requires a smaller pump. 

 High Surface Tension- Leakage problems are reduced by it.  

 Chemical Inertness – It should not react with surfaces with which it comes into contact. 

 Chemical Stability - It should not decompose under prolonged use. 



Page | 5  

 

 Nontoxic- It should be safe for personnel to handle. 

 Low Freezing And High Boiling Points – It extends the useful temperature range.  

 Low Cost- Different fluids may be selected in different applications because of the 

different priorities set in the selection process. 

 

Pump is used in this system for feeding liquid. Some liquid cooling pumps are submersible, and 

can be placed directly inside the coolant reservoir. Pump is shown in following figure – 

 

 

                                 

 

 

Fig 1.3 A pump for a liquid cooled PC 

Source: http://computer.howstuffworks.com/liquid-cooled-pc3.htm 

 

 

 

 

 

 

 

 



Page | 6  

 

1.3.3 Hybrid Air-Water Cooling  

 In this type of system, a water-cooled heat exchanger extracts heat from heated air stream and 

reduces temperature. This cooling system consists of a heat exchanger of air-to-water finned tube 

type. Forced type convection with air was used to cool the module located on board. High 

temperature air entered into a heat exchanger before entering into next module. Up to fifty percent 

of heat is transferred to cooling water by high temperature air. Liquid-to-air type cooling system 

is a variation of this type cooling system. In this type cooling, there is a sealed loop. Through this 

coolant is circulated. There is an electronic module through which cold plate is attached to 

dissipate heat. Heat is carried away by liquid to heat exchanger of air cooled type. Further it is 

transferred to atmospheric air.  

 

1.3.4 Refrigerant Cooling  

In this type of cooling system, chemical coolants are used. These systems work like very small 

refrigerator. A block is added on processor, liquid runs over the block and transfers heat away 

from the chip and outside the case. This cooling system also removes the need of noisy case 

cooling fans. Cost of refrigerant cooling system is very high. 

 

1.3.5 Heat Sink  

It is a block of metal which is attached to the part which needs cooling. In CPU of personnel 

computers, it is clamped over the chip. A thermal conductive material is used in between block 

of material and component upon which it is clamped. It is called thermal interface material (TIM). 

Generally thermal grease or thermally conductive pad is in between the both. Microprocessors 

and power handling semiconductors are examples of electronics that need a heat sink to reduce 

their temperature through increased thermal mass and heat dissipations. Heat sinks have 

application in heat engines, refrigeration and cooling of electronic devices like microprocessors 

etc. 
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Fig 1.4 A heat sink uses lots of surface area to transfer heat from electronic components to air 

Source: http://computer.howstuffworks.com/liquid-cooled-pc1.htm 

 

 These are made of different materials. Figure shows the thermal conductivities of different 

material used for heat sink- 

 

1.3.6 Microchannel Heat Sink  

Microchannel heat sinks were introduced in the early 1980s to be used as a means of cooling 

integrated circuits. The implementation of manifold microchannel heat sink, cooling micro heat 

pipes, pool boiling, multiphase flow, liquid metal heat sink and microchannel heat sink are also 

proposed for the cooling solution in microelectronics. Heat is removed fifty times more 

effectively than conventional systems by microchannel heat sink. Thermal stress is induced on 

the chips by one layer type microchannel heat sink due to high temperature. High temperatures 

can be avoided by high pressure drop. Because high pressure drop causes rapid flow of coolant 

in channel. It will require a pumping system which will be large and noisy. Multi-layered MCHS 

are strong improvement on previous designs of one layered MCHS. There is current flow 

mechanism in multi-layered microchannel heat sink. Thermal performance of these MCHS was 

analysed. To optimize the design parameters a procedure was suggested. Although system of 
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power supply in multilayer MCHS is simpler than one layered MCHS yet temperature rise was 

less on base surface. 

In comparison to one layered MCHS, required pressure drop is significantly less in multi-layered 

MCHS. It has been shown that the thermal resistance is low up to 0.03 0C/W for MCHS. Thermal 

resistance is significantly lower in multi layered MCHS than conventional heat sinks. Dimension 

of micron scale in microchannels increases heat transfer rate substantially in comparison to 

conventional heat sinks. It is advantageous for electronics cooling.  

 

                            

 

                                                  

Fig 1.5 Microchannel heat sink with manifolds 

Source: www.uk.comsol.com/model/download/.../microchannel_heatsink 

 

Microchannel heat sinks have attracted special attention because of their ability size. Less coolant 

is required in it. An extensive research has already been done on microchannels. Still researchers 

are working in this field in present. Electronic packaging engineers got some relief by the 

introduction of nanofluids in the field of cooling of electronic devices. To increase the efficiency 

and the performance of systems, nanofluids can be used. Suspension of nanosized particles of 

metals, oxides, carbides or carbon nanotubes in base fluid is known as nanofluid. Thermal 

conductivity of the nanofluids is more so these exhibit better results. 
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1.3.7 Working Fluid in Microchannel Heat Sink  

With the rapid development of the information technology (IT) industry, the heat flux in 

integrated circuit (IC) chips cooled by air has almost reached its limit about 100 W/cm2. So water 

is used as a coolant. Nanofluids are also tested by researchers. The MCHS wall temperature 

decreases with the increase of particle volume fraction under the extreme heat flux of 1000 W/m2 

as compared with lower heat flux. The heat transfer coefficient at φ=5% of Al2O3–H2O nanofluid 

flow could not enhance or performing almost the same result as pure water compared with lower 

particle volume fractions. The presence of the nanoparticles in water flowing through MCHS 

appears to give only a slight rise in the friction factor values. Thus the friction factor increases 

as the percentage of nanofluids particle volume fraction increases. Besides these, the hot water 

cooling enables efficient recovery of heat dissipated by the even hotter chip by using hot water 

recovered from a secondary application.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page | 10  

 

Chapter 2                                                                  TERMINOLOGY 

 

Heat Sink  

Heat sink is a metal object which is placed over an electronic chip. Heat is transferred from one 

side of heat sink which is dissipated from another surface. 

Microchannel Heat Sink  

Microchannel heat sink has a number of channels through which coolant flows. Heat is carried 

away by this coolant from hot device. 

Nanofluid 

Suspension of nanosized particles of metals, oxides, carbides or carbon nanotubes in base fluid 

is known as nanofluid. Different base fluids are being used like glycerin, water, oil, ethylene 

glycol. One of the most important property of nanofluids is their high thermal conductivity. 

Advantages of nanofluid include enhanced heat transfer. It will lead to lighter and smaller heat 

exchanger. Disadvantages of nanofluid include channel clogging, sedimentation of particles, 

costly, toxicity, erosion. 

Computational Fluid Dynamics 

Science of predicting fluid flow, heat and mass transfer, and other related phenomenon by solving 

mathematical equations which govern these processes using numerical methods is known as 

Computational Fluid Dynamics. 

ICEM CFD and FLUENT 

ICEM CFD is a complete pre-processing software. Geometry can be created in it or imported. 

Mesh can be created in ICEM. This mesh cab be exported for several solvers like FLUENT, CFX 

etc. 

 FLUENT is a solver. User applies different operating, boundary conditions for a mesh imported 

in FLUENT. FLUENT solves the problem according to applied conditions. 
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Chapter 3                                                               SCOPE OF STUDY 

 

Various nanofluids have developed at present. Microchannels show different characteristics for 

different nanofluids. So it is important to investigate for suitable combination of nanofluid and 

geometry of channel, which provides better performance of microchannel heat sink. It is suitable 

to investigate this using computational fluid dynamics (CFD). CFD is the science of predicting 

fluid flow, heat transfer, mass transfer, chemical reactions and related phenomenon by solving 

mathematical equations which govern these processes using numerical methods. 

Present research deals with fluid flow and heat transfer analysis of microchannel heat sink. 

Channel is of trapezoidal shape. Nanofluid is used as a coolant in microchannel. Nanofluid TiO2- 

H2O is taken as a coolant. Effect of this nanofluid on the performance of microchannel heat sink 

is studied. Pro E, ICEM CFD 14.0 and FLUENT 14.0 softwares are used in this research. Heat 

transfer coefficient will be calculated. Nusselt number will also be calculated. Water is taken as 

a base fluid for nanofluid (TiO2-H2O). For volume fraction (ɸ = 2%), properties of nanofluid 

(TiO2-H2O) are calculated using correlations available from literature review. Silicon is taken as 

material of heat sink. This study will also cover a comparison of performance of microchannel 

heat sink having water as coolant and nanofluid (TiO2-H2O) as coolant. Geometry of cooling 

model is created in Pro E Wildfire 4.0. It is imported in ICEM CFD 14.0, in which mesh is 

created. This mesh will be read by FLUENT 14.0. Results will be obtained for different pressure 

drop and amount of heat flux at the bottom of single microchannel heat sink by applying different 

boundary conditions, operating conditions and other conditions. 
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Chapter 4                                                     LITERATURE REVIEW 

 

A substantial amount of work has been done in the area of microchannel heat sink for cooling of 

electronic chip. Studies are performed on heat transfer rate through channel, thermal resistance, 

Nusselt number, friction factor, entropy generation and some other parameter also. Literature 

review is classified in following three categories-   

 

4.1 Experimental Study  

Tuckerman and Pease [1] performed research on microchannel heat sink in 1981. It was 

concluded that heat transfer rate would increase by decreasing liquid cooling channel dimensions. 

In it, for dissipating the heat, silicon microchannels were used with water as working fluid. They 

had a channel width of approximately 60 μm and a parameterized channel height varying between 

287 μm and 376 μm. 

 

G. Hetsroni et al. [2] has performed investigation of a heat sink for cooling of electronic devices 

by using a dielectric liquid as a coolant. The temperature on the hot surface maintained in the 

range 323–333 K by cooling fluid in this study. It was concluded that the entire behaviour of 

temperature variations corresponds to that of pressure variations. The maximum pressure 

variations did not differ significantly from the pressure drop across the channels. 

 

Piyanut Nitiapiruk et al. [3] investigated the performance of a microchannel heat sink using 

TiO2/water nanofluid experimentally. Width, height and length of microchannel were 500, 800 

and 40 mm. There were 40 channels in microchannel heat sink. Effects of different thermal and 

physical properties on the Nusselt number and friction factor were investigated by using three 

different sets of thermophysical models. These were based on theoretical and experimental 

relations. It was concluded that the use of the model which is based on experimental data is very 

important to estimate the friction factor on using different models. Prediction of Nusselt number 

did not depend upon thermal conductivity much. 

 

H.Y. Wu, Ping Cheng [4] experimentally investigated the laminar convective heat transfer and 

pressure drop of water in 13 different trapezoidal silicon microchannels. It was determined that 

the Nusselt number and apparent friction constant depend greatly on different geometric 
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parameters. Nusselt number and friction constant increased with the increase of surface 

roughness and surface hydrophilic property. These increments became more obvious at higher 

Reynolds numbers. It was also showed experimentally that the Nusselt number would increase 

almost linearly with the Reynolds number at low Reynolds numbers (Re < 100), but increases 

slowly at a Reynolds number greater than 100. 

 

4.2 Numerical Study 

Harpole and Eninger [5] suggested mainfold microchannel heat sinks first time. There were many 

inlets and outlets in manifold MCHS in comparison to the conventional microchannel heat sinks 

along the length of the microchannels. Coolant flows from the inlet port in to the manifolds and 

forms different streams. Every stream flowed through a short part of microchannels. The pressure 

drop was reduced by a factor equal to the number of manifold inlet/outlet compared with 

conventional microchannel heat-sink. 

 

Li et al. [6] numerically simulated a forced convection heat transfer with rectangular micro 

channel. Width, depth and hydraulic diameter of microchannel 57 μm, 180 μm and 86 μm 

respectively, fabricated along entire length. The effect of the geometric parameters of the channel 

and thermo physical properties of the fluid on the flow and the heat transfer, were investigated 

using temperature dependent thermo physical property method. Result showed that these liquid’s 

properties could significantly influence both the flow heat transfer in the micro channel heat sink. 

The result indicated that the variations in the way the Nusselt number is defined may results in 

different conclusions even using the same experimental data. 

 

Weilin Qu, Issam Mudawar [7] performed numerical investigation the three-dimensional fluid 

flow and heat transfer in a rectangular micro-channel heat sink numerically using water as the 

cooling fluid. A numerical code based on the finite difference method and the SIMPLE algorithm 

was developed to solve the governing equations. It was found that the temperature rise along the 

flow direction in the solid and fluid regions can be approximated as linear. The highest 

temperature was spotted at the heated base surface of the heat sink just above the channel outlet. 

Heat flux and Nusselt number near the channel inlet had higher values. These parameters varied 

around the periphery and zero at corners. 
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Chander Shekhar Sharma [8] presented a detailed thermo-hydrodynamic analysis of a hot water 

cooled manifold microchannel heat sink for electronic chip cooling. The hot water cooling 

enabled efficient recovery of heat dissipated by the even hotter chip by using hot water recovered 

from a secondary application. This analysis showed that entropy generation due to heat transfer 

would dominate the net entropy generation in the heat sink for both conditions. Although entropy 

generation due to viscous dissipation increased significantly with increased Reynolds number, it 

still would contribute less than a third to the total entropy generated at high Reynolds numbers. 

Component of entropy generation was reduced significantly due to use of hot water, second law 

efficiency was increased. 

 

X.L et al [9] performed numerical study of laminar heat transfer and pressure drop characteristics 

in a water-cooled minichannel heat sink. The results indicated that heat transfer performance 

would increase by a narrow, deep and thin channel with a relatively high but acceptable pressure 

drop. A configuration of heat sink was approximately optimized which could cool a chip having 

256 W/cm2 heat flux of at 0.205 W pumping power. 

 

J. Koo, C. Kleinstreuer [10] simulated and analyzed liquid nanofluid flow in microchannels by 

considering two types of nanofluids, i.e., CuO nanospheres at lower volume concentrations in 

water or ethylene glycol. Based on this study, high-Prandtl number carrier fluids was 

recommended for microchannel heat sink. High volume concentrations nanoparticles of about 

4% with increased thermal conductivities and dielectric constants very close to that of the carrier 

fluid, microchannels with high aspect ratios were also recommended for the microchannel heat 

sink.   

 

Manay et al. [11] numerically investigated the pressure drop and laminar convection heat transfer 

characteristics of nanofluids in microchannel heat sink with square duct. The water based 

nanofluids created with Al2O3 and CuO particles in four different volume fractions of 0%, 0.5%, 

1%, 1.5% and 2% are used to analyze their effects on heat transfer. The results were determined 

in terms of pressure drop, Nusselt number and heat transfer coefficient. Analysis showed that the 

nanofluids would enhance heat transfer while the Reynolds number and the volume fractions 

were increasing. The best overall enhancement was obtained at φ=2% and Re=100 for CuO-

water nanofluid. 
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Seok Pil Jang, Stephen U.S. Choi [12] investigated the cooling performance of a microchannel 

heat sink with nanoparticles – fluid suspensions (‘‘nanofluids’’) numerically. A theoretical model 

of thermal conductivity of nanofluids was that account for the fundamental role of Brownian 

motion, they investigated the temperature contours and thermal resistance of a microchannel heat 

sink with nanofluids such as 6 nm copper- in-water and 2 nm diamond-in-water. The results 

showed that the cooling performance of a microchannel heat sink with water-based nanofluids 

containing 1%, vol. 2 nm diamond at the fixed 2.25W pumping power, was enhanced by about 

10% in comparison of microchannel heat sink with water as coolant. Thermal resistance and the 

temperature difference both between the heated wall and the coolant were reduced on using 

nanofluid in microchannel heat sink.  

 

H.A. Mohammed et al. [13] investigated the effect of using nanofluids on heat transfer and fluid 

flow characteristics in rectangular shaped microchannel heat sink (MCHS) numerically for 

Reynolds number range of 100–1000. In this study, the MCHS performance was examined using 

alumina–water (Al2O3-H2O) nanofluid as coolant with volume fraction ranged from 1% to 5%. 

The results revealed that when the volume fraction of nanoparticles was increased under the 

highest heat flux, the heat transfer coefficient and wall shear stress both would increase while the 

thermal resistance of the MCHS would decrease. Only a slight increase in the pressure drop 

across the MCHS was found compared with the pure water-cooled MCHS. 

 

Bhanu Pratap Singh et al. [14] did CFD modelling to know the effect of number of channel with 

symmetrical geometry. Two models having rectangular and trapezoidal cross section were 

chosen. It was found that performance of symmetrical channel had a good agreement when 

compared with the single channel microchannel heat sink. 

 

Harry Garg et al. [15] used COMSOL multi physics module in integration with Fluid Flow & 

Conjugate Heat transfer Module. Investigations had been conducted to better understand & 

establish the fluid flow & heat transfer characteristics in different micro channel heat sinks. 

Different parameters like heat transfer rate, heat transfer coefficient and temperature at outlet 

were studied with different flow rates and an optimum best range of flow rate for all the fluids 

separately by considering maximum heat transfer rate, minimum base temperature and less 

pumping power had been considered. 
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Navin Raja Kuppusamy et al. [16] studied the thermal and flow fields in a trapezoidal grooved 

microchannel heat sink (TGMCHS) using nanofluids. The governing and energy equations were 

solved using the finite volume method. The effect of the geometrical parameters on the thermal 

performance of TGMCHS was examined. At different Reynolds numbers, the effects of different 

nanoparticle types, volume fraction, particle diameter and base fluid were also studied. It was 

found that the increment of the maximum width ‘a’ and reduction of the minimum width ‘b’ of 

the trapezoidal groove gave the maximum thermal performance. It was shown that Al2O3-H2O 

had the highest thermal performance with 4% volume fraction and 25 nm diameter. 

 

Mostafa Mirzaei and Maziar Dehghan [17] investigated laminar flow and heat transfer of Al2O3-

water nanofluid under constant heat flux numerically. Heat transfer was enhanced. An increase 

in friction factor had been also obtained by the use of nanofluid. Heat transfer enhancement was 

more evident by the use of variable properties. Effects of temperature variation on nanofluid heat 

transfer were greater than the pure water. 

 

Ping Li et al. [18] investigated flow and heat transfer characteristics of Al2O3–water nanofluids 

in the microchannel with dimple and protrusion surface are investigated for the first time in order 

to improve the efficiency of compact heat exchanger and microchannel heat sinks. They studied 

the influence of nanoparticle volume fraction ϕ (0–3%), and geometrical parameters of 

microchannel on flow and heat transfer characteristics in detail. Three similar microchannel 

structures were adopted in their work, which were smooth, dimpled and 

dimpled plus protrusioned microchannel. The results showed that the relative Fanning friction 

factor f/f0, Nusselt number Nu/Nu0 and thermal performance TP would increase with the increase 

of U for nanofluids. 

 

H.A Mohammed et al. [19] performed numerical investigations to investigate the laminar flow 

and heat transfer characteristics of trapezoidal microchannel heat sink using different types of 

base nanofluids and various substrate materials on MCHS performance. Four types of base fluids 

including water, ethylene glycol (EG), oil, and glycerin with 2% volume fraction of diamond 

nanoparticle were considered in this study. It was found that the best uniformities in heat transfer 

coefficient and temperature among the four mixture flows could be obtained using nanofluid 

which had glycerin as base fluid.  
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Roy W. Knight et al.[20] presented the equations governing the fluid dynamics and combined 

conduction/convection heat transfer in a heat sink in dimensionless form for both laminar and 

turbulent flow. This study was useful to determine heat sink’s dimensions that displayed the 

lowest thermal resistance between the hottest portion of the heat sink and the coming fluid. 

Results from the this method were applied to heat sinks to study effects of their restrictions 

regarding the nature of the flow (laminar or turbulent), the ratio of fin thickness to channel width, 

or the aspect ratio of the fluid channel. Results indicated that when the pressure drop through the 

channels was small, laminar solutions yield lower thermal resistance was obtained by laminar 

solutions in comparison to turbulent solution, when pressure drop was small through channel. 

 

Mohammad Kalteh et al. [21] examined study the laminar convective heat transfer of an alumina-

water nanofluid flow inside a wide rectangular microchannel heat sink numerically and 

experimentally. A microchannel was made using a silicon wafer with glass layers for 

experimental study. A two-phase Eulerian-Eulerian method using the finite volume approach 

was adopted for the numerical study. The two-phase results showed that the velocity and 

temperature difference between the phases were very small and negligible. The average Nusselt 

number increased with an increase in Reynolds number and volume concentration as well as with 

a decrease in the nanoparticle size. 

 

Saeed Zeinali Heris et al. [22] numerically investigated laminar flow-forced convective heat 

transfer of Al2O3-water nanofluid in a triangular duct under constant wall temperature condition. 

In it the effects of different parameters like diameter of nanoparticles, concentration, and 

Reynolds number on the enhancement of heat transfer was studied. Numerical results represented 

an enhancement of heat transfer of fluid associated with changing to the suspension of nanometer 

sized particles in the triangular duct. The results of that model indicated that the nanofluid Nusselt 

number would increase with increasing concentration of nanoparticles and decreasing diameter. 

 

Deewakar Sharma [23] analyzed the double layer configuration for rectangular ducts. In this 

study performance of trapezoidal shape double layer microchannel heat sink was investigated 

and compared to rectangular double layer heat sink of same flow area. The performance was 

evaluated on the basis of maximum temperature attained at the heated surface as well as 

minimum temperature variations. Finally the best performing configuration was compared with 

double layer rectangular heat sink. Analysis proved that among various trapezoidal 
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configurations, the one with larger side face to face was most suitable. Comparative study with 

rectangular system showed that performance of trapezoidal double layer heat sink was superior 

in both aspects. 

 

Yue-Tzu Yang et al. [24] performed numerical study of trapezoidal MCHS using CuO-H2O as 

coolant. Particle volume fraction and volumetric flow rate were studied. It was shown that 

thermal resistance would decrease with increasing particle volume fraction and volumetric flow 

rate. 

 

H.A. Mohammed et al. [25] numerically investigated Al2O3-H2O, Ag-H2O, CuO-H2O, diamond-

water, SiO2-H2O and TiO2-H2O for triangular shaped microchannel heat sink. Heat transfer 

coefficient was minimum for Al2O3-H2O but it had highest temperature. Heat transfer coefficient 

was maximum for diamond-water. Highest pressure drop and highest wall shear stress occurred 

in case of SiO2- H2O. 

 

4.3 Other Study 

Deewakar Sharma et al. [26] analyzed the performance of trapezoidal and rectangular 

microchannels and compared for two different coolants, liquid gallium and water. Performance 

was compared on the basis of maximum temperature at hot surface. For water as coolant the 

performance of rectangular type was found to be superior in terms of flow rate and pump power. 

For liquid gallium as a coolant, microchannels having A-type cross-section was found to be 

performing better followed by V-type then rectangular type at same flow rate. While comparing 

on the basis of pump power the rectangular type of geometry was more suitable than trapezoidal. 

 

Weilin Qu and Issam Mudawar [27] explored several issues important to the thermal design of 

single-phase and two-phase micro-channel heat sinks. First half portion of study dealt with 

single-phase heat transfer in rectangular micro-channels. Experimental results were compared 

with predictions based on both numerical as well as fin model. The best agreement between 

predictions and experimental results was accomplished with numerical simulation, a few of the 

fin models were found to provide fairly accurate predictions. 

 

C.Y. Zhao, T.J. Lu [28] performed analytical and numerical study on the heat transfer 

characteristics of forced convection across a microchannel heat sink. The porous medium model 
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and the fin approach, these two approaches were used. In the porous medium approach, Darcy 

equation (modified) was used for the fluid and the two-equation model was used for heat transfer 

between the solid and fluid phases. Effect of channel aspect ratio and effective thermal 

conductivity ratio on the overall Nusselt number of the heat sink were determined in this study. 

Both approaches showed that the overall Nusselt number (Nu) would increase as aspect ratio 

would increase and decrease with increasing thermal conductivity. 

 

Ahmed Mohammed Adham et al. [29] reviewed the available studies regarding non-circular 

microchannels heat sinks with emphasis on rectangular microchannels. Different parameters 

were reviewed in this study. The review showed that studies from 1981 to 1999 were largely 

performed using experimental or analytical approaches while more recent studies from 2000 to 

the end of 2012 performed numerically. It was also found laminar was the prevailing flow 

condition as out of the 69 articles reviewed, 54 employed laminar flows. It was found that the 

use of liquid coolants was preferable over gaseous coolants. Recent researches in nanofluids are 

providing alternative coolants.  

 

Shakuntala Ojha [30] investigated rectangular microchannel heat sink using water as a coolant. 

Heat transfer coefficient, Nusselt number were studied for different pressure drop and heat flux 

in this study. Semi implicit method was used for fully developed laminar flow in microchannel 

heat sink. Maximum temperature was found at bottom of channel outlet. Maximum heat transfer 

coefficient and Nusselt number was found maximum at inlet region.    
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Chapter 5                                            OBJECTIVE OF THE STUDY 

 

Through this extensive literature survey it is found that CFD analysis of fluid flow and heat 

transfer through microchannel heat sink having trapezoidal microchannels using nanofluid TiO2- 

H2O has not been performed yet. It is also clear from literature review that water was used 

previously in microchannels as a coolant. But due to heat dissipation limitations of water, other 

coolants are introduced. In recent times, nanofluids are developed. It is important to check 

performance of microchannel heat sink using nanofluid as coolant.  

 So in this thesis, cfd analysis of fluid flow and heat transfer through microchannel heat sink 

having trapezoidal channels is investigated by using TiO2 nanofluid which has not been done yet. 

ANSYS ICEM CFD 14.0 and FLUENT 14.0 softwares are used. Objective is to perform 

following –  

 Simulating single MCHS for various pressure drop. 

 Determining pressure, velocity and temperature profiles for constant heat flux on the 

bottom of the sink. 

 Determining temperature distribution along the channel. 

 To determine heat transfer coefficient and Nusselt number for various pressure drop at 

constant heat flux and different heat flux. 

 To make a comparison between performance of microchannel heat sink using nanofluid 

and water. 

  

Results will be validated with the previous results available from literature review.  
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Chapter 6                                         RESEARCH METHODOLOGY 

 

6.1    Introduction 

An isometric view of microchannel heat sink having trapezoidal channel is shown in the figure 

6.1. Various dimensions of this microchannel heat sink are shown in the figure 6.2. A constant 

heat flux is applied at the bottom of surface. Here heat transfer is a conjugate problem which 

combines conduction and convection. Heat is transferred by conduction through solid and 

dissipated away by cooling fluid by convection.  

 

 

Fig 6.1 Isometric View of Complete Microchannel Heat Sink Created In PRO-E Wildfire 4.0 
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Fig 6.2 Various Dimensions Of MCHS (in mm) 

 

Single microchannel heat sink is shown in the figure 5.3 below. Various dimensions are listed 

in the table 5.1. A constant heat flux is supplied at the bottom surface of heat sink at y = 0. Top 

surface of sink which is at y = h is well insulated. Hydraulic diameter for trapezoidal channel is 

calculated using formula given in equation 5.12. 
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Fig 6.3 Isometric View of Single Microchannel in Heat Sink Created In PRO-E Wildfire 4.0 

Table 6.1 Dimensions of Trapezoidal Channel 

 

 

Where all dimensions are in (μm) 

 

In table, 

 a = channel top width for trapezoidal cross-section MCHS 

 b = channel bottom width for trapezoidal cross-section MCHS 

 c = channel hypotenuse for trapezoidal cross-section MCHS 

 h = channel height for trapezoidal cross-section MCHS 

Lc = channel length 

S = distance between two micro channels 

Dh = hydraulic diameter 

t = 1.8 mm (distance from left face/right face of sink to left/right face of channel) 

a b c h Lc S Dh 

280 225 431 430 10000 500 318 



Page | 24  

 

Sb = 0.54 mm (distance from base of sink to bottom of channel) 

W = width of the sink = 4 mm 

H = height of sink = 1.5 mm 

 

6.2 Mesh Generated In ICEM CFD 14.0   

ICEM CFD 14.0 is a meshing software which is used to create mesh for single microchannel heat 

sink. After creating geometry in PRO E Wildfire 4.0, IGES file is imported in ICEM CFD 14.0. 

Geometry imported in ICEM CFD 14.0 is shown in figure given below. 

 

  

 

 

Fig 6.4 Geometry Imported In ICEM CFD 14.0 

 

 After importing geometry file in IGES format, a volume mesh is created for it. Trapezoidal 

microchannel is made fluid zone and rest is made solid. Different faces are assigned names as 

inlet, outlet, channel, heat flux wall, insulated top, insulated right, insulated left. The step wise 

procedure is given in appendix І. 
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Fig 6.5 Mesh generated in ICEM CFD 14.0 

 

 

 

Fig 6.6 Solid view of Mesh 

Mesh generated contains 1856699 total elements and 326858 total nodes. This mesh is exported 

to FLUENT 14.0. 
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6.3 Boundary Conditions and Governing Equations   

Following assumptions are made for applying Navier Stokes Equation and energy equation to 

the model – 

 Flow is laminar and steady 

 Solid and fluid properties are constant 

 Heat Flux at the bottom surface is uniform 

 Fluid is incompressible 

 Radiation heat transfer is negligible 

For a flow which is fully developed continuity, momentum and energy equations are given as 

below, 

 

Continuity Equation 

 

∂u

∂x
+

∂v

∂y
+

∂w

∂z
= 0                                                                                                     (6.1) 

 

                                          

Momentum Equation 

 

X-momentum equation 

 

𝜌 (𝑢
𝜕𝑢

𝜕𝑥
+ 𝑣

𝜕𝑢

𝜕𝑦
+ 𝑤

𝜕𝑢

𝜕𝑧
) = −

𝜕𝑝

𝜕𝑥
+ 𝜇 (

𝜕2𝑢

𝜕𝑥2
+

𝜕2𝑢

𝜕𝑦2
+

𝜕2𝑢

𝜕𝑧2
)                            (6.2) 

 

Y-momentum equation 

 

𝜌 (𝑢
𝜕𝑣

𝜕𝑥
+ 𝑣

𝜕𝑣

𝜕𝑦
+ 𝑤

𝜕𝑣

𝜕𝑧
) = −

𝜕𝑝

𝜕𝑦
+ 𝜇 (

𝜕2𝑣

𝜕𝑥2
+

𝜕2𝑣

𝜕𝑦2
+

𝜕2𝑣

𝜕𝑧2
)                             (6.3) 

 

Z-momentum equation 

 



Page | 27  

 

𝜌 (𝑢
𝜕𝑤

𝜕𝑥
+ 𝑣

𝜕𝑤

𝜕𝑦
+ 𝑤

𝜕𝑤

𝜕𝑧
) = −

𝜕𝑝

𝜕𝑧
+ 𝜇 (

𝜕2𝑤

𝜕𝑥2
+

𝜕2𝑤

𝜕𝑦2
+

𝜕2𝑤

𝜕𝑧2
)                        (6.4) 

 

Energy Equation 

 

𝑢
𝜕𝑇

𝜕𝑥
+ 𝑣

𝜕𝑇

𝜕𝑦
+ 𝑤

𝜕𝑇

𝜕𝑧
=

1

𝛼
(

𝜕2𝑇

𝜕𝑥2
+

𝜕2𝑇

𝜕𝑦2
+

𝜕2𝑇

𝜕𝑧2
)                                                   (6.5) 

  

 

 

6.3.1 Boundary Conditions   

Following boundary conditions are specified for the single microchannel heat sink. 

 

 

Pressure at inlet, 

 

for, 𝑡 < 𝑥 < 𝑡 + 𝑏, 𝑆𝑏 < 𝑦 < 𝑆𝑏 + ℎ and 

                                

At  𝑧 = 0, 𝑝1 = 𝑝𝑖𝑛                                                                                                        (6.7) 

 

Velocity in y and z direction is zero, so 

 

                             

  v = 0, w = 0                                                                                                                (6.8) 

 

Pressure at outlet, 

 

for, 𝑡 < 𝑥 < 𝑡 + 𝑏, 𝑆𝑏 < 𝑦 < 𝑆𝑏 + ℎ and 

                              

At  z=𝐿𝑐,  𝑝1 = 𝑝𝑜𝑢𝑡                                                                                                      (6.9)                     
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At the bottom surface, constant heat flux is applied, 

 

At 𝑦 = 0, 0 < 𝑧 < 𝐿𝑐 and 0<x<W, 

                           

                                

𝑞′′ = −𝑘𝑠

𝜕𝑇

𝜕𝑦
                                                                                                             (6.10) 

Inlet Temperature, 

                           

                        At 𝑧 = 0, 𝑡 < 𝑥 < 𝑡 + 𝑏 and 𝑆𝑏<y<𝑆𝑏 + ℎ, 

 

                             

𝑇 = 𝑇𝑖𝑛                                                                                                                         (6.11) 

 

Hydraulic diameter, 

 

                                                    

𝐷ℎ =
4𝐴

𝑃
=

2(𝑎 + 𝑏)ℎ

(𝑎 + 𝑏 + 2𝑐)
                                                                                       (6.12) 

 

6.4 Properties of Nanofluid and Sink Material   

Here silicon is taken as material of the sink. Properties of this are listed in following table- 

Table 6.2 Properties of Silicon 

 

 

Properties of nanofluid (TiO2- H2O) are calculated using correlations [31]. Properties of 

nanofluid are listed in the table. 

Material 
Density(ρs) 

(kg/m3) 

Thermal 

Conductivity 

ks  (w/m-k) 

Specific Heat 

cps (J/kg-k) 

Silicon 2330 148 712 
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For density of nanofluid, 

                                                      

𝜌𝑛𝑓 = (1 − 𝜑)𝜌𝑏𝑓 + 𝜑𝜌𝑝                                                                                        (6.13) 

 

Where, 

ρnf =  density of nanofluid     

𝜑 =  particle volume fraction 

𝜌𝑏𝑓 =  density of base fluid 

𝜌𝑝 =  density of particle 

 

For thermal conductivity of nanofluid, 

 

𝑘𝑛𝑓 =  
𝑘𝑝 + 2𝑘𝑏𝑓 + 2(𝑘𝑝 − 𝑘𝑏𝑓)𝜑

𝑘𝑝 + 2𝑘𝑏𝑓 − (𝑘𝑝 − 𝑘𝑏𝑓)𝜑
𝑘𝑏𝑓                                                              (6.14) 

 

Where, 

knf =  thermal conductivity of nanofluid 

kp =  thermal conductivity of particle 

kbf =  thermal conductivity of basefluid 

 

For viscosity of nanofluid, 

 

μnf =  μbf(1 + 2.5φ)                                                                                                (6.15) 

 

Where, 

 

μnf =  viscosity of nanofluid 

μbf =  viscosity of basefluid 

 

For heat capacity of nanofluid, 
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(ρc)nf = (1 − φ)(ρc)bf + φ(ρc)p                                                                        (6.16) 

 

Where,      

(ρc)nf = heat capacity of nanofluid 

(ρc)nf = heat capacity of basefluid 

(ρc)p = heat capacity of particle  

 

In nanofluid (TiO2- H2O), water (H2O) is base fluid. Properties of the water are listed in 

following table- 

Table 6.3 Properties of Water 

Fluid 
(ρf) 

Kg/m3 

(kf) 

W/m-K 

(µf) 

kg/m-s 

(cp) 

J/kg-K 

Water 998.2 0.6 0.001003 4182 

  

After applying above values of base fluid’s properties in formulae following properties for 

nanofluid (TiO2-H2O) are obtained- 

Table 6.4 Properties of TiO2-H2O 

Fluid 
(ρnf) 

Kg/m3 

(knf) 

W/m-K 

(µnf) 

kg/m-s 

(cp) 

J/kg-K 

TiO2-H2O 1063.236 0.64364 

 

0.00105315 

 

3902.53 

 

 

6.5 FLUENT as Solver   

Fluent will be used as solver for this research. Three popular solvers are available in ANSYS 

FLUENT. These are given below- 

 Pressure Based Segregated Solver (PBSS) 

 Pressure Based Coupled Solver (PBCS) 

 Density Based Coupled Solver (DBCS) 

Among above three, first one PBSS will be used for following reasons – 
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 It is suitable for incompressible fluid as assumption is made.  

 It solves three momentum equations, continuity and energy equations. It update velocity 

also.  

 Pressure based segregated solver is applicable to wide variety of problems.  

 It requires less memory or lower RAM requirements.  

 This solver is also quick than other solvers. 

  

As pressure based segregated solver is chosen for pressure velocity coupling, default algorithm 

in FLUENT, semi implicit method for pressure linked equation (SIMPLE) will be used. It is 

most robust algorithm among others available in FLUENT like SIMPLEC, PISO and coupled. 
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Chapter 7                                            RESULTS AND DISCUSSION 

 

7.1 Validation of Study 

Present study is validated by convergence graph and grid independence test. Previous 

numerical study is also used to validate the results of current study. 

7.1.1 Convergence Graph  

Fig.7.1 shows convergence graph. On solving problem in FLUENT, iterations are converged 

after 45 iterations. 

 

Fig. 7.1 Convergence Graph 

 

7.1.2 Grid Independence Test 

Grid independence test is done to validate the results. Three mesh are generated to ensure the 

accuracy of final results. Results are evaluated by outlet temperature. These three mesh 

contains 1.7 million, 0.7 million and 0.4 million cells respectively. These are summarized in 

table. Variation in outlet temperature is very less for these coarse, fine and very fine mesh 

created for solving the problem in FLUENT. Difference between temperature for fine and 

very fine mesh is very less. So mesh containing 1.7 million cells is most suitable for 

performing simulation of trapezoidal single channel microchannel heat sink using solver 

FLUENT.  
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Table 7.1 Grid Independence Test 

Mesh Number Of Cells Outlet Temperature 

Mesh 1 1721028 378 

Mesh 2 701391 377.8 

Mesh 3   445884 377.6 

 

7.1.3 Validation of Results with Numerical Study 

Results of current study are validated by a previous numerical study in terms of heat transfer 

coefficient. This previous study was done by J. Li et al. [6] who performed numerical 

simulation of rectangular microchannel heat sink using water as coolant in channel. Results 

are matching with previous study as there is increase in heat transfer coefficient due to use 

of nanofluid. Fig.7.2 shows the variation of heat transfer coefficient in present study and 

previous numerical study by J. Li et al. 

 

 

Fig. 7.2 Validation of results by numerical study in terms of heat transfer coefficient  
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7.2 Temperature Contours 

Fluid entered at 293K and its temperature was increased along the flow direction. It is shown 

in Fig. 7.3. Temperature was increased to 375K.Temperature contour at inlet and outlet is 

shown in Fig. 7.4. And Fig. 7.5. 

 

 

Fig. 7.3. Temperature distribution along the channel 
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Fig. 7.4. Temperature distribution at inlet 

 

 

 

 

Fig. 7.5. Temperature distribution at outlet under pressure 50000 Pa and 900000 W/m2 heat flux 

 

Following figures (from Fig. 7.6. to show the temperature contours at inlet and outlet for 

different pressure drop and heat flux.  
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Fig. 7.6. Temperature distribution at outlet under pressure 10000 Pa and 900000 W/m2 heat flux  

 

 

 

 

 

 

Fig. 7.7. Temperature distribution at outlet under pressure 20000 Pa and 900000 W/m2 heat flux  
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Fig. 7.8. Temperature distribution at outlet under pressure 35000 Pa and 900000 W/m2 heat flux  

 

 

 

Fig. 7.9. Temperature distribution at outlet under pressure 65000 Pa and 900000 W/m2 heat flux 
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Fig. 7.10. Temperature of fluid inside the channel under pressure 50000 Pa and 900000 W/m2 heat flux  

 

 

 

Fig. 7.11. Temperature of fluid inside the channel under pressure 10000 Pa and 900000 W/m2 heat flux  

 

 

Fig. 7.12. Temperature of fluid inside the channel under pressure 35000 Pa and 900000 W/m2 heat flux 
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Fig. 7.13. Temperature of fluid inside the channel under pressure 20000 Pa and 900000 W/m2 heat flux 

 

 

Fig. 7.14. Temperature of fluid inside the channel under pressure 65000 Pa and 500000 W/m2 heat flux 

 

 

Fig. 7.15. Temperature of fluid inside the channel under pressure 50000 Pa and 500000 W/m2 heat flux 
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Fig. 7.16. Temperature of fluid inside the channel under pressure 50000 Pa and 1500000 W/m2 heat flux 

Following figures show temperature contours of channel walls for different pressure drop 

and heat flux. 

 

 

 

 

. 

Fig. 7.17. Temperature of channel in pressure 50000 Pa and 900000 W/m2 heat flux 
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Fig. 7.18. Temperature of channel in pressure 10000 Pa and 900000 W/m2 heat flux 

 

 

 

 

Fig. 7.19. Temperature of channel in pressure 35000 Pa and 900000 W/m2 heat flux 
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Fig. 7.20. Temperature of channel in pressure 20000 Pa and 900000 W/m2 heat flux 

 

 

 

 

 

 

Fig. 7.21. Temperature of channel in pressure 65000 Pa and 900000 W/m2 heat flux 
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Fig. 7.22. Temperature of channel in pressure 50000 Pa and 500000 W/m2 heat flux 

 

 

 

Fig. 7.23. Temperature of channel in pressure 50000 Pa and 1500000 W/m2 heat flux 
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7.3 Pressure Contours 

At 293K and 50000 Pa, fluid entered in channel. Fluid came out at outlet at atmospheric 

pressure. Pressure contour inside the in y-z plane is shown in Fig. 7.24. Heat flux of 900000 

W/m2 is applied at bottom surface of heat sink.  

 

Fig. 7.24. Pressure distribution inside the channel 

 

 

Table 7.2 Outlet temperature at different pressure drop 

Pressure drop (KPa) Tin (K) Tout (K) 

10 293 429 

20 293 402 

35 293 387 

50 293 378 

65 293 374 

 

7.4 Velocity Vector 

Fig. 7.25 shows the velocity vectors at inlet and outlet of microchannel heat sink. 

Maximum velocity is at inlet. 
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Fig. 7.25 Velocity Vectors at inlet and outlet 

 

7.5 Heat transfer coefficient 

Heat transfer coefficient is calculated. Variation of heat transfer coefficient with flow 

direction is shown in Fig. 7.26. From figure it is clear that value of heat transfer coefficient 

is very high at inlet. Because of increasing boundary layer heat transfer coefficient decreases 

in direction of flow. It is calculated using following expression: 

𝑞′′ = ℎ∆𝑇 

  

 

Fig.7.26. Variation of heat transfer coefficient in direction of flow 

Fig. 7.27 shows the variation of heat transfer coefficient along the direction of flow for water 

and nanofluid as a coolant in trapezoidal microchannel heat sink. Heat transfer coefficient is 

high for nanofluid as coolant in comparison of water as a coolant in trapezoidal microchannel 

heat sink. 
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Fig.7.27. Variation of heat transfer coefficient for nanofluid and water 

 

 

 

 

7.6 Nusselt Number 

Variation of Nusselt number along the flow direction for different pressure drop is shown in 

Fig. 7.28. Nusselt number is defined as: 

𝑁𝑢 =
ℎ𝐿

𝑘
 

 

Where, L= hydraulic diameter of trapezoidal channel and k is thermal conductivity of 

nanofluid. 
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Fig. 7.28. Variation of Nusselt number in direction of flow 

Value of Nusselt number for 50000 Pa is obtained which is 74.  Because of boundary layer 

formation, average Nusselt number is decreasing along the direction of fluid flow. At 

entrance, values of average Nusselt numbers for 20000 Pa and 10000 Pa are approximately 

same. Nusselt number decreases sharply for each value of pressure drop in channel, after 

some distance from inlet Nusselt number does not change. It remains constant. 

                                Fig.7.29. shows the variation of Nusselt number in channel for nanofluid 

and water as a coolant in microchannel heat sink. Value of Nusselt number is high in case 

when coolant is nanofluid in comparison of water as coolant in trapezoidal microchannel heat 

sink.  
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Fig. 7.29. Variation of Nusselt number for nanofluid and water 

 

7.7 Variation of Heat Transfer Coefficient with Heat Flux 

Single channel trapezoidal microchannel heat sink is also simulated by applying different 

heat flux at the bottom surface of heat sink. Heat transfer coefficient variation is checked 

along the length of channel. Fig. shows the variation of heat transfer coefficient along the 

direction of flow for different heat fluxes. 

  Fig.7.30 shows the variation of heat transfer coefficient along the direction of 

flow with different amount of heat fluxes. High heat flux causes increase in heat transfer 

coefficient along the direction of flow. Due to development of boundary layer and increase 

in thickness of boundary layer in inlet region, heat transfer coefficient’s value is high in this 

region.       
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Fig. 7.30. Variation of heat transfer coefficient along the direction of flow 

 

7.8 Variation of Nusselt number with Heat Flux 

Fig.7.31 shows the variation of Nusselt number along the direction of flow with different 

amount of heat fluxes. High heat flux causes increase in Nusselt number along the direction 

of flow. Due to development of boundary layer and increase in thickness of boundary layer 

in inlet region, Nusselt number’s value is high in this region.       

 

 

 

Fig. 7.31 Variation of Nusselt number along the direction of flow 
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Chapter 8                             CONCLUSION AND FUTURE SCOPE 

 

8.1 Conclusion 

In this study, numerical simulations on two dimensional fluid flow and three dimension heat 

transfer are performed. Conjugate heat transfer problem is solved to investigate performance 

of microchannel heat sink. Effect of nanofluid (TiO2-H2O) on different parameters is studied. 

Some assumptions are also made to solve this conjugate heat transfer problem, which 

involves conduction as well as convection. On the basis of presented results in previous 

chapter following conclusions can be described: 

 Because of low fluid velocity, maximum temperature occurs below the channel 

outlet. Heat flux is concentrated at that particular region due to fluid’s low 

velocity.  

 Outlet temperature is maximum for 10000 Pa pressure drop and 900000 W/m2 

heat flux. On increasing the heat flux, outlet temperature increases because it 

increases temperature of fluid due to more heat transfer by convection. Outlet 

temperature is maximum for 1500000 W/m2
 heat flux. Velocity of fluid is low for 

low pressure drop. So during low pressure drop temperature of fluid rises more. 

Velocity of fluid is high for high pressure drop. So during high pressure drop 

temperature of fluid rises less.   

 Comparison of heat transfer coefficient is done for water and TiO2-H2O.   

 In comparison to water as coolant, heat transfer coefficient is increased on using 

nanofluid. 

 Nusselt number is high for nanofluid as coolant in comparison to the water as 

coolant.  

 Nusselt number and heat transfer coefficient are maximum at inlet region and 

decreases along the direction of flow. Thickness of boundary layer is very less in 

inlet region so Nusselt number and heat transfer coefficient both are very high in 

this region. But with the development of boundary layer along the direction fluid 

flow, thickness of boundary layer increases. So both these parameters decrease 

along the direction of fluid flow. Nusselt number is high on using nanofluid (TiO2-

H2O). 
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8.2 Future Scope 

If problems associated with nanofluids are solved, nanofluids definitely will be used as 

coolants in microchannel heat sink. 

 As fluid’s temperature remains very high few times so performance of microchannel 

heat sink can be studied using multiphase analysis.  

 As nanofluids are suspension of nanoparticles of oxides in base fluid, two phase 

model can also be considered for microchannel heat sink. 
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                                                                                           APPENDIX І 

 

CFD analysis of single microchannel heat sink, involves following steps- 

(1) Pre-Processing 

(2) Solver  

(3) Post-Processing 

Preprocessing involves geometry creation and mesh of geometry. Here geometry of single 

microchannel heat sink is created in Pro E Wildfire 4.0 and exported in ICEM CFD 14.0 in IGES 

format. Solver performs numerical computations. Third and last step is post processing which 

involves report generation and understanding flow with different plots and contours. 

 

Steps in Pro E Wildfire 4.0 for Creating Single microchannel Heat Sink- 

After opening the Pro E Wilfire4.0, 

File > Set Working Directory > Ok 

New > Part > mmns_ part_solid > Ok 

Select Front Plane > Sketch rectangle of dimensions 4×1.5 mm2 > Extrude 10mm > ok 

Select Front Face > Sketch > Draw trapezoidal channel of dimensions specified in table > 

Extrude 10mm > Cut > ok 

File > Save A Copy in IGES format. 

 

Steps in ICEM CFD 14.0 for Meshing – 

After opening ICEM CFD 14.0, 

File > Import Geometry > STEP/IGES > Select Geometry File > Open > Apply 

Assigning names to different parts, 

Right click on create part > Part Name (Channel) > Select entities comprises channel > apply, 

similarly inlet, outlet, insulated top, insulated left, insulated right, heat flux name are assigned to 

different surfaces in the geometry. 

Creating Body- Fluid body and solid body are defined by following below steps- 

Create Body > Part Name > Fluid > Select two diagonally opposite corners of channel > apply 

again, Part name > Solid > select two diagonally opposite corners of sink > apply 

 

Repair Geometry > Tolerance > 0.005 > Apply 
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Creating Volume Mesh –  

Mesh > Global Mesh Setup > Max element >10 >apply >volume meshing parameters > Mesh 

type >Tetra/mixed > apply 

Part mesh Setup > Following values are assigned for different parts > apply 

 

 

 

 

 

Compute Mesh > Volume Mesh >Mesh Type > Tetra/Mixed > Mesh Method > Robust (octree) 

> Select Geometry > From File > Select tin file > Open > Compute 

 

Check Quality of Mesh –  

Right click on mesh > Color by quality >  
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Save Mesh > ok 

Writing input file for FLUENT 14.0- 

Output > Output Solver > Fluent_V6 > Ok, 

Write input > Save as > File name > nastran > save 

 

Solver 

Launch ANSYS FLUENT 14.0 as given below, 
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Click on ok 

File > read > mesh…select fluent (MESH file) > ok 

 

 

 

 

 

Mesh > check 

Scale > mesh was created in > mm > scale > close 

 

 

 

 

Models > energy > on 
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Materials > fluid > enter properties of nanofluid 

 

Materials > solid > enter properties of solid 

Boundary conditions > heat flux 
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Boundary conditions > inlet > edit 
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Walls of sink are insulated. 

 

Define > operating conditions 
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Solution methods > pressure, momentum, energy > second order upwind 

Solution controls 

 

Monitors > Residuals- Print, Plot 
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Solution initialization > standard initialization >compute from > heat flux 

Run calculation > number of iterations > 100 > calculate 

                                                                       


